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Manage support contracts

Look up Micro Focus support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require you to register as a Passport user and sign in. Many also require a support
contract.

To register for a Passport ID, go to hitps://cf.passport.softwaregrp.com/hppcf/llogin.do.

To find more information about access levels, go to
https://softwaresupport.hpe.com/web/softwaresupport/access-levels.

To check for recent updates or to verify that you are using the most recent edition of a document, contact
your Client Director.
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Chapter 1: Taxonomy Editor Guide

Welcome to the Taxonomy Editor User Guide. This guide describes how to use Taxonomy Editor as part of Micro Focus Cloud
Assessment (Micro Focus Cloud Assessment).

This guide contains the following chapters:

« Taxonomy Editor, on page 8
Provides an overview of the main features of Taxonomy Editor.
« Getting Started, on page 17
Describes the installation of the main features and shows you how to create a taxonomy project.
« Managing Taxonomies, on page 23
Explains how to create, download, edit, and compare taxonomies.
« Deploying Taxonomies, on page 29
Shows how to publish taxonomies and build and deploy a Taxonomy Extension.
« Conflicts and Validation Issues, on page 34
Shows how to resolve conflicts with taxonomies.
« Example: Creating and Publishing a Department Taxonomy, on page 36
A walkthrough example of creating and deploying a new taxonomy.
« Keyboard Shortcuts, on page 37
Keyboard shortcuts reference.
« Dialog Boxes Reference, on page 39
Dialog box reference.
« Troubleshooting, on page 44
Troubleshooting tips.



Chapter 2: Taxonomy Editor

Micro Focus Cloud Assessment is a set of Micro Focus Cloud Assessment Workbench features that enable
you to manage taxonomies in Micro Focus Cloud Assessment.

You can use Taxonomy Editor to create, modify, and delete taxonomies. You can also download taxonomies
from, or upload them to, any number of Micro Focus Cloud Assessment servers.

This chapter introduces Taxonomy Editor in the following sections:

« Overview, on the next page

« User Interface, on the next page

Micro Focus Cloud Assessment Workbench

Cloud Assessment Workbench consists of the following tools, enabling you to customize your deployment of
Micro Focus Cloud Assessment.

o Assertion EditorAssertion Editor

Customizes the conditions applied by your business policies within Micro Focus Cloud Assessment. For
more information, see Micro Focus Cloud AssessmentAssertion Editor User Guide.

o Customization EditorCustomization Editor

Customizes the underlying System Data Model (SDM) within Micro Focus Cloud Assessment. For more
information, see Micro Focus Cloud AssessmentCustomization Editor User Guide.

« Report EditorReport Editor

Customizes report definitions for use with Micro Focus Cloud Assessment. For more information, see
Micro Focus Cloud AssessmentReport Editor User Guide.

« Taxonomy EditorTaxonomy Editor

Customizes the taxonomies used to categorize artifacts in Micro Focus Cloud Assessment. For more
information, see Micro Focus Cloud AssessmentTaxonomy Editor User Guide.

« Customization Editor Customization Editor

Customizes the underlying System Data Model (SDM) within Micro Focus Cloud Assessment. For more
information, see Micro Focus Cloud Assessment Customization Editor User Guide.

« Taxonomy Editor Taxonomy Editor

Customizes the taxonomies used to categorize artifacts in Micro Focus Cloud Assessment. For more
information, see Micro Focus Cloud Assessment Taxonomy Editor User Guide.

« Assertion Editor Assertion Editor

Customizes the conditions applied by your business policies within Micro Focus Cloud Assessment. For
more information, see Micro Focus Cloud Assessment Assertion Editor User Guide.

« Report Editor Report Editor

Customizes report definitions for use with Micro Focus Cloud Assessment. For more information, see
Micro Focus Cloud Assessment Report Editor User Guide.
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Overview

Taxonomies are, in their simplest form, a visual representation of what your organization actually
knows. A well-constructed, meaningful taxonomy enables users in your organization to quickly find the
information they need to achieve their goals.

Taxonomy Editor enables you to organize and reorganize content easily, giving more flexibility for
knowledge sharing in your organization

Use Taxonomy Editor to do the following:

1. Create a Taxonomy Project.
For details, see the following sections:
« Creating a Taxonomy Project, on page 19
« Downloading Taxonomies from a Server, on page 21
« Searching for Taxonomies, on page 21
2. Create and Manage Taxonomies.
For details, see the following sections:
o Creating Taxonomies, on page 23
« Editing Taxonomies, on page 23
« Editing Categories, on page 24
« Deleting and Restoring Taxonomies, on page 26
« Comparing Taxonomy Files, on page 27
« Updating Taxonomies from the Server, on page 27
« Importing and Exporting Taxonomy Files, on page 28
3. Publish taxonomies to an Micro Focus Cloud Assessment server.
For details, see the following sections:
« Publishing Taxonomies, on page 29
« Deploying Taxonomies, on page 29
4. Check local validity and manage conflicts.

For details, see Conflicts and Validation Issues, on page 34.

User Interface

The default perspective is split into a number of sections, with menu options across the top. as shown
in the following screenshot.
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Screenshot: Taxonomy Editor Ul
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The platform perspective consists of the following views:

« Project Explorer

The tree view of your taxonomy projects. For details, see Project Explorer, below.

« Server Explorer

The view listing Micro Focus Cloud Assessment server connections to the Micro Focus Cloud
Assessment Workbench. For details, see Server Explorer, on page 12.

« Editor

The view showing the components of the taxonomy. For details, see Editor View, on page 13.

Project Explorer

Project Explorer contains a hierarchical list of projects, the taxonomies in each project, and the
categories and subcategories of each taxonomy, as shown in the following screenshot.
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Screenshot: Project Explorer
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The Project Explorer contains additional context menu options enabling you to interact with a running
Micro Focus Cloud Assessment server. Right-click the project name or a particular assertion, and
select Cloud Assessment to view the options listed in the following tables.

Project Context Menu Options
Option Function

Download Import taxonomies from Micro Focus Cloud Assessment. For details, see
Taxonomies Downloading Taxonomies from a Server, on page 21.

Upload to Export taxonomies to the default Micro Focus Cloud Assessment server. For details,
Server see Publishing Taxonomies, on page 29.

Update from Update taxonomies from Micro Focus Cloud Assessment. For details, see Updating
Server Taxonomies from the Server, on page 27.

Remove Delete taxonomies from Micro Focus Cloud Assessment. For details, see Deleting
from Server = and Restoring Taxonomies, on page 26.

Upload To Export taxonomies to a specified Micro Focus Cloud Assessment server.

Other

Server

Build Create a taxonomy extension for Micro Focus Cloud Assessment containing all the
Extension taxonomies in your project. For details, see Building a Taxonomy Extension, on page

30.
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Taxonomy Context Menu Options

Option

Upload to
Server

Update from
Server

Remove from
Server

Upload To
Other Server

Validate Data
Consistency

Show
Taxonomy
Usage

Compare With
Latest From
Server

Build
Extension

Function

Export a taxonomy to the default Micro Focus Cloud Assessment server. For
details, see Publishing Taxonomies, on page 29.

Update a taxonomy from Micro Focus Cloud Assessment. For details, see
Updating Taxonomies from the Server, on page 27.

Delete the taxonomy from Micro Focus Cloud Assessment. For details, see
Deleting and Restoring Taxonomies, on page 26.

Export a taxonomy to a specified Micro Focus Cloud Assessment server.

Check the validity of the taxonomies. For details, see Conflicts and Validation
Issues, on page 34.

Find the artifacts that use the taxonomy for categorization. For details, see
Conflicts and Validation Issues, on page 34.

Compares the selected taxonomy with the latest version on the server.

Create a taxonomy extension for Micro Focus Cloud Assessment containing all
the taxonomies in your project. For details, see Building a Taxonomy Extension,
on page 30.

Server Explorer

The Server Explorer displays the Micro Focus Cloud Assessment servers connected to Micro Focus
Cloud Assessment Workbench. , as shown the following screenshot. The functionality is shared by all
the Micro Focus Cloud Assessment Workbench editors.

Screenshot: Server Explorer View
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Right-click a server in the Server Explorer to open the context menu described in the following table.
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Server Explorer Context Menu Options
Option Function

New Server Add a server for downloading assertions and taxonomies (Assertion Editor,
Taxonomy Editor, and Customization Editor).

Remove Delete a server from the Server Explorer.
Server
Download Download a taxonomy from a server (Taxonomy Editor and Customization Editor).
Taxonomy
Download Download assertions from a platform server (Assertion Editor).
Assertion
Download Download reports from a reporting server (Report Editor).
Report
Properties View and edit the server name, URL, username, and password.
Editor View

The Editor pane is the main feature of the Taxonomy Editor UI.
It has four tabs, described in the following sections:

« Overview Tab
The Overview tab shows the components of the taxonomy.

ddi sy P ry-sd OA £

Overview

~ General Information

Name: SOA Systinet

Taxonomy ID: T OA_Systinet

Name with parents
Name with parents (Value)

~ Origin

Resource URL: hitp: [s0a/systinet/platform/restBasic/r: /i m-systinet-re; OA-Systinet

Overview | Categories| Advanced | Source

The first section is General Information, where you can view and edit the following properties:
o Name

Name for the taxonomy. The content of the name element in the taxonomy's XML representation.
o Taxonomy ID

Identifier for the taxonomy, with the preceding uddi:. The value of tModelKey attribute in the
taxonomy's XML representation.
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o Description
Description of the taxonomy (optional).
The second section is Origin, which shows:
o Resource URL
REST interface URL enabling the published taxonomy to be viewed on the server.
o Value Display Format
These options allow changing how the value is presented.

Categories Tab

The Categories tab enables you to change the structure and properties of taxonomy categories.

=0

=(m

Categories

Category Structure

[= 5 SOA Systinet (SOA Systinet) TR
F Taxonomy Editor (Taxanomy Editar)
add chid

Category Information

Name | Taxonomy Editor

Value | Taxonomy Editor
[ Disabled

You can use the Categories tab to do the following:
o Adding a Category, on page 25
o Removing a Category, on page 25

o Copying a Category, on page 25

o Moving a Category, on page 26

Advanced Tab

The Advanced tab enables you to set properties used with UDDI.

Taxonomy Advanced Properties

Compatibility
tiodel businessService businessEntty bindingTemplate

Categorization

Didentifier [Crelationship

categorization

Validation

@ checked internal
O checked external
Validation Service Endpoint

verson 3 |

Verson 2

version 1: |

Reference to

[enttykey [ousinesskey [Oservicekey [bindingkey [ tModekey [ subscriptionkey

Value type

(@ system comparator | systinet-com:comparator:string

Comparator name: [

O custom comparator
Transformer service endpoint: |

Overview | Categories | Advanced | Source |

Itis divided into the following sections:
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o Compatibility

Enables you to select one or more of the main UDDI structures for the taxonomy. For example,
businessEntity, businessService, bindingTemplate, and tModel.

All structure types are selected by default which is the required setting if you want your taxonomy
to integrate with UDDI Registry.

o Categorization
Enables you to select from the following taxonomy types:
m categorization

Tags the UDDI structure with additional information, such as identity, location, and
description.

= categorizationGroup

Groups several categorizations into one logical category. For example, a
categorizationGroup could be a geographical location comprised of two categorizations:
longitude and latitude.

The categorizationGroup option is disabled if the taxonomy has any categories.
= |dentifiers
Reference published information in businessEntities and tModels.
m Relationships
Defines the relationship between two businessEntities in Publisher Assertions.
o Validation

Sets whether or not the values in keyedReferences within the taxonomy are checked. The
validation service can check the expected syntax of values. For example, a credit card number or
an ISBN number.

Validation can be against Taxonomy Editor's internal validation service or against an external
service.

To select an external validation service, do one of the following:
= Enter the endpoint URL.
m Leave keyedReferences unvalidated.
o Reference
Enables you to add a reference to a key type.
o Value Type
Enables you to Select a Value type for keyValues, using one of the following comparators:
= em-com.comparator.string
keyValues are treated as string values. The maximum length is 255 characters.
= em-com.comparator.numeric

keyValues are treated as decimal numbers. The value can have a maximum of 19 digits
before the decimal point and a maximum of 6 digits after the decimal point.

= em-com.comparator.date
keyValues are treated as dates.
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= custom
Endpoint URL of a custom comparator.
» Source Tab
The Source tab enables you to view and directly edit the XML representation of the taxonomy.

() *uci-com-systinet-repository-sdm-taxenemies-SOA-Systinet, xml % =0
v3/5.5m>
Systinet™ deleted:

systinet.com/uddi/taxonomy

ocalhost:soa:model:taxonomies:SOR

v3">SOR Systinet</name>

"false" xmlns="http://systinet.com/uddi/taxonomy/v3/5.0">

<categoryBag xmlns
<keyedReference tModelXey:
<keyedReference tModelKey="uddi
<keyedReference tModel¥ey:
<keyedReference tModelXey:
<keyedReference tModelXey: : gorizationitypes” keyName="
</categoryBag>
</tModel>
<compatibilityBag xmlns="http://syst
<compatibility>tModel</compatibility>
<compatibility>businessService</compatibilityy
<compatibility>businessEntity</compatibility>
<compatibility>bindingTemplate</compatibility>
</compatibilityBag>
<categorizationBag xmln:
<categorizationycategorization</categorization>
</categorizationBag>
<validation xmlns="htr
<categories>
<category keyName="SOR Syst.
<category keyName:
</category>
</categories>
</validation>
_</taxonomy>

tHodel"/>
businessService"/>

et . com/uddi/taxonomy/v3/5

ttp://systinet.com/uddi/taxonony/vw3/5.0">

tinet.com/uddi/caxonomy/v3/5.0">

"false">

nec” keyValue="SOL Systinec” disable

Taxonomy Editor" keyValue="Taxonomy Editor” disabled="false"/>

Overview | Categaries | Advanced | source
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Chapter 3: Getting Started

This chapter describes the prerequisites for working with taxonomies in Taxonomy Editor. It contains the
following sections:

« Installing Cloud Assessment Workbench, below

« SSL Configuration, on page 19

« Creating a Taxonomy Project, on page 19

o Customizing Taxonomy Editor, on page 20

« Downloading Taxonomies from a Server, on page 21
« Searching for Taxonomies, on page 21

Installing Cloud Assessment Workbench

Cloud Assessment is an Eclipse development platform distributed as a zip file, microfocus-
cloudassessment-workbench-1.01-win64.zip.

NOTE:
Cloud Assessment requires Java SE Development Kit (JDK) 1.8.0 (64 bit version only) or higher. You
must include the path to this version of the JDK in the JAVA_HOME environment variable.

(missing or bad snippet)
To Start Cloud Assessment:

o Execute WB_HOME/workbench/start.exe.
The first time you start Micro Focus Cloud Assessment Workbench, the welcome screen opens.

Screenshot: Workbench Welcome Screen

Develop Assertion Develop Taxonomy

Create Assertion Project Create Taxonomy Project
Go to Platform Perspective Go to Platform Perspective
Help Help

Design Report Customize SOA Model

Create Report Project Create Extension Project
Go to Platform Perspective Go to Extension Perspective
Help Help

Select one of the options to open one of the editor tools, start a new editing project, or view the documentation
set.
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You can return to the welcome screen from any of the editor tools by selecting Help > Welcome from
the menu options.

TIP:

By default, Micro Focus Cloud Assessment Workbench runs in 'normal' mode which prevents
users from uploading system taxonomies (IDs start with
uddi:systinet.com:soa:model:taxonomies)and the Report Editor . rptlibrary file to Micro
Focus Cloud Assessment servers. If you need to work with system taxonomies or want to
upload the . rptlibrary file you can switch Micro Focus Cloud Assessment Workbench into
'admin' mode.

CAUTION:

Be extremely careful when working with system taxonomies, Micro Focus Cloud Assessment
uses some hard-coded values from system taxonomies. Changing or removing them may
cause errors.

To Switch Micro Focus Cloud Assessment Workbench to Admin Mode

Open WB_HOME/configuration/config.ini with a text editor.
2. Add mode=adminto config.ini.
Restart Micro Focus Cloud Assessment Workbench.

TIP:
Micro Focus Cloud Assessment is memory-intensive. If you experience performance issues,
Micro Focus recommends increasing the memory allocation.

To increase the memory allocation for Micro Focus Cloud Assessment:

4. Open WB_HOME/workbench/start.ini for editing.
5. Set these new values:
e -Xms128m
e -Xmx1024m
6. Save your changes.
7. Restart Micro Focus Cloud Assessment Workbench.

TIP:
Micro Focus Cloud Assessment downloads from Micro Focus Cloud Assessment may time
out. If you experience issues, Micro Focus recommends increasing the time out.

To increase the time out for Micro Focus Cloud Assessment:

Open WB_HOME /workbench/start.ini (oreclipse.ini for stand-alone installation) for editing.
2. Set the new value:

-Dorg.cloudassessment.platform.rest.Client.timeout=200000

The value is in milliseconds with a default value of 120000 (2 minutes).
3. Save your changes.

Restart Micro Focus Cloud Assessment Workbench.
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TIP:
Workbench may fail to store saved credentials of servers. In such cases, Micro Focus
recommends clearing the secure storage.

To reset the secure storage for Cloud Assessment server credentials:

1. In Cloud Assessment, go to Windows > Preferences > General > Security > Security
Storage > Contents tab.

2. Click root node Default Secure Storage and then click Delete button.

3. Restart the Workbench.

SSL Configuration

By default, Micro Focus Cloud Assessment Workbench trusts all Micro Focus Cloud Assessment
server certificates. You may want Micro Focus Cloud Assessment Workbench to verify Micro Focus
Cloud Assessment certificates.

To Verify Micro Focus Cloud Assessment Server Certificates:

« Add the following options to WB_HOME /workbench/start.ini:

-Dcom.microfocus.cloudassessment.security.ssl.verifyCert=true
-Djavax.net.ssl.trustStore=USER_TRUSTSTORE
-Djavax.net.ssl.trustStorePassword=TRUSTSTORE_PASS
-Djavax.net.ssl.trustStoreType=TRUSTSTORE_FORMAT

If Micro Focus Cloud Assessment is configured for 2-way SSL, you must provide Micro Focus Cloud
Assessment Workbench certificates to Micro Focus Cloud Assessment.

To Provide Micro Focus Cloud Assessment Workbench Client Certificates to Micro Focus
Cloud Assessment:

« Add the following options to WB_HOME /workbench/start.ini:

-Djavax.net.ssl.keyStore=USER_KEYSTORE
-Djavax.net.ssl.keyStorePassword=KEYSTORE_PASS
-Djavax.net.ssl.keyStoreType=KEYSTORE_FORMAT

Creating a Taxonomy Project

To work with taxonomies, you need a Taxonomy Project. You can create any number of Taxonomy
Projects to help organize your work.

To Create a Taxonomy Project:

1. Do one of the following:

« Inthe Micro Focus Cloud Assessment Workbench Welcome page, click Create Taxonomy
Project.

o Click New " toopen the Select a Wizard window, and select Cloud Assessment >
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Taxonomy Project.
« From the menu, select File > New > Taxonomy Project.

« Press Alt+Shift+N, and then press R, to open the Select a Wizard window. Then select Cloud
Assessment>Taxonomy Project.

The New Taxonomy Project dialog box opens.
2. Inthe New Taxonomy Project dialog box, enter the following parameters:

Parameter Definition

Project The name of your assertion project.
Name

Taxonomy The URN prefix to apply to all taxonomies in the project.

ID Prefix

Createfrom  Select this option if you want to create a new project from a previous taxonomy
Existing extension. If selected, input the path or browse for the location of the
Extension taxonomyn extension.

Use Default  If selected, Taxonomy Editor stores the project in your default workspace. If
Location unselected, input the path or browse for an alternative workspace.
3. Click Next to select or create a server.
Note: If no servers are currently defined, the dialog box continues to step 5.
4. Do one of the following:
« Select Create a New Server, and click Next.
Continue to step 5.

« Select Use an Existing Server, select the server from the list and input its credentials, and
then click Next.

Continue to step 6.
In the New Server dialog box, add the required parameters, and then click Next.

6. Select the taxonomies to download from the server. Optionally, select Show System
Taxonomies to view system taxonomies for selection.

7. Click Finish.

Customizing Taxonomy Editor

Some settings are customizable in Taxonomy Editor.
To Change Taxonomy Editor Preferences:

1. Select Window > Preferences.
The Preferences dialog box opens.
2. Inthe tree menu, select Cloud Assessment > Taxonomy Editor.

3. You can change the following:
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« Default taxonomy namespace

The default namespace setting is 5.5. This defines taxonomy compatibility level with other
UDDI products.

« Data consistency

Select Validate before publishing taxonomies to validate changes before publishing them to
the server

Downloading Taxonomies from a Server

Initially, Taxonomy Editor does not contain any taxonomies. To edit Micro Focus Cloud Assessment
taxonomies, you must download them from a server.

To Download Taxonomies from a Server:

1.

3.

In Server Explorer, right-click the server containing the taxonomies you need to open its context
menu, and select Download Taxonomies.

The Download Taxonomies wizard opens.

Select the taxonomies to download and click Next.

The Choose Location dialog box opens.

Select the project to add the taxonomies to, and then click Finish.

Taxonomy Editor displays the download progress. When the download is complete, the taxonomies are
visible in Project Explorer.

Searching for Taxonomies

This section describes the search facilities provided by Taxonomy Editor.

Quick Find is the easiest way to find a taxonomy.

To use Quick Find:

1.

Do one of the following:
« Click Search, and then select Quick Jump.
o Press Ctri+J.
The Find Taxonomy dialog box opens. For details, see Find Taxonomy Dialog, on page 41.
In the input field, enter a search string.
Click View Menu ~, and then select one of the following options:
« Show in the tree without opening detail
Shows the taxonomy in the tree but does not open its details page.
« Case-sensitive
Enables a case-sensitive or case-insensitive search.
Inthe in project field, select in which project to search for the taxonomy.
Taxonomies that match your search criteria are displayed in the Matching taxonomies pane.
Select the required taxonomy and click Open taxonomy.
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The taxonomy opens in the Editor pane.
For a more detailed search, you can use Advanced Search to do the following:

« Search for a specific property type.

« Search according to a specific value of a property.

« Search different text strings: full text, regular expression, or whole word.
To Use Advanced Search:

1. Do one of the following:
« Select Search>Search.
o Press Ctri+H.
The Search dialog box opens.

2. Select the Taxonomy Search tab to open the dialog box. For details, see Search Taxonomy
Dialog, on page 42.

3. Inthe Containing text field, do one of the following:
« Enterthe text to search.
« Select text used in a previous search by using the drop-down list.
4. InSearch only in, choose the taxonomy properties or categories to search.
InSearch controls, select one or more of the following:
« Case-sensitive
To perform a case-sensitive search.
« Whole words only
To search for whole word matches.
« Regular expression
To search using regular expressions.
6. InScope, select one of the following:
« Workspace
To search the Eclipse workspace.
« Selected resources
To search all entities selected in Project Explorer.
« Working set
To customized resources from Project Explorer.
7. Click Choose.
The Select Working Sets wizard opens.
Do one of the following:
« Select from existing working sets.
« Create new working sets.
8. Click Search.
The results are displayed in the Search view of the Ul.
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This chapter describes how to work with taxonomies, as detailed in the following sections:

Creating Taxonomies, below

Editing Taxonomies, below

Editing Categories, on the next page

Deleting and Restoring Taxonomies, on page 26
Comparing Taxonomy Files, on page 27

Updating Taxonomies from the Server, on page 27

Importing and Exporting Taxonomy Files, on page 28

Creating Taxonomies

In Creating a Taxonomy Project, on page 19, you created a Taxonomy Project and looked at how to download
taxonomies. The following section describes how to create new taxonomies.

To Create a New Taxonomy:

1.

Do one of the following:

« Click New " to open the Select a Wizard dialog box, and select Cloud Assessment >
Taxonomy, and then click Next.

« Select File > New > Taxonomy.

« Press Alt+Shift+N to open the context menu, and then select Taxonomy.
The New Taxonomy wizard opens.

In the New Taxonomy wizard, enter the required parameters.

NOTE:

Note: A default Taxonomy ID and Filename are assigned according to the Taxonomy Name
entered. The Source Folder is assigned by default, according to whether there is an active
extension project. You can change these parameters to meet your requirements.

Click Finish to create the taxonomy.
The taxonomy is now visible in Project Explorer and the Taxonomy Editor opens.

Open the Categories tab and add the categories you need. For details, see Editing Categories, on the
next page.

Open the Advanced tab and enter the required parameters, as described in Editor View, on page 13.

Editing Taxonomies

A taxonomy can be modified in the following ways:
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« Editing Taxonomy Properties, below
« Refreshing Taxonomies to Reflect External Changes, below

« Copying Taxonomies, below

Editing Taxonomy Properties

To Edit Taxonomy Properties:

1. Double-click the taxonomy in Project Explorer to open the Editor view.
2. Edit properties as required in the tabs of the Editor view. For details, see Editor View, on page 13.
3. Click Save.

The changed status of the taxonomy is displayed in Project Explorer.

Refreshing Taxonomies to Reflect External Changes

If you want the Editor to reflect changes made outside Taxonomy Editor, you can refresh the
taxonomy.

To refresh a taxonomy, do one of the following:

« Right-click the individual taxonomies or the project in Project Explorer to open the context menu, and
then select Refresh.

« Select the individual taxonomies or the project in Project Explorer, and then press F5.
The selected taxonomies are then updated to reflect exteral changes.

Copying Taxonomies

You can copy or move taxonomies from one project to another using cut, copy, or paste.
To Copy or Move a Taxonomy to a Different Project:

1. Right-click the taxonomy in Project Explorer and select Copy or Cut.
2. Right-click the project to which you want to copy or move the taxonomies and select Paste.
The taxonomies are then either copied or moved to the other project.
A pasted taxonomy has the status:
o« New
If a taxonomy of that name is new to that location.
« Modified

If an existing taxonomy is overwritten.

Editing Categories

A taxonomy can be maodified in the following ways:
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« Adding a Category, below
« Removing a Category, below
Copying a Category, below

« Moving a Category, on the next page

Adding a Category

To Add a New Category to a Taxonomy:
1. Open the required taxonomy in the Editor pane and click the Categories tab.
2. Do one of the following:
o Click Add Nextto add a new category at the same level.
« Click Add Child to add a new sub-category.
The New Category wizard opens.
3. Enter the category properties, as follows:
« Name

Name for the category. This represents the value of the keyName attribute in the taxonomy's
XML representation.

« Value

Identifier for the category. This represents the value of the keyvalue attribute in the
taxonomy's XML representation.

« Disabled

Select this check box to make sure the category cannot be used in an artifact.
4. Click Finish.
The new category is displayed in Category Structure.

Removing a Category

To Remove a Category:

1. Open the required taxonomy in the Editor pane and click the Categories tab.

2. Right-click the category in the Category Structure pane to open its context menu, and select
Delete.

The deleted category is no longer visible in the Category Structure pane.

Copying a Category

To Copy a Category:

1. Open the required taxonomy in the Editor pane and click the Categories tab.

2. Right-click the required source category in the Category Structure pane to open its context menu,
and then select Copy or Cut.

3. Right-click the required destination category in the Category Structure pane to open its context
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menu.
4. Do one of the following:
« Select Paste to add the category as a sub-category.

« Select Paste as Sibling to add the category at the same level.

Moving a Category

To Move a Category:

1. Open the required taxonomy in the Editor pane and click the Categories tab.
2. Select the required category in the Category Structure pane.
3. Do one of the following:

« Click Up, to move a category up.

« Click Down, to move a category down.

« Click Unindent, to move a category to the left.

« Click Indent, to move a category to the right.

NOTE:
Note: To move multiple categories at the same time, you must select categories that are
consecutive.

Deleting and Restoring Taxonomies

You can also delete taxonomies and restore them from your local history.
To Delete a Local Taxonomy:

1. Right-click the taxonomy in Project Explorer to open its context menu, and then select Delete.
2. Confirm deletion of the taxonomy when prompted.
To Restore a Deleted Taxonomy:

1. Right-click the project in Project Explorer to open its context menu and select Restore from
Local History.

The Restore from Local History dialog box opens.
Select the check box of the required taxonomy and click Restore.

Download the published taxonomy from the server, as described in “Downloading Taxonomies
from a Server”.

To Delete a Taxonomy from the Server:

1. Right-click the taxonomy in Project Explorer to open its context menu and select Cloud
Assessment > Remove from Server.

2. Choose if you also want to delete the local copy.

3. Confirm deletion of the taxonomy when prompted.

NOTE:
Note: Taxonomy Editor automatically performs a data consistency check before removing the
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I taxonomy from the server. For details, see “Conflict With Server”.

Comparing Taxonomy Files

If you are importing or exporting taxonomies between servers, it is essential to compare taxonomies to
keep track of changes.

Taxonomy Editor enables you to compare the following taxonomies:
« Local taxonomy against the server taxonomy.

« Server taxonomy against a local history taxonomy.

To Compare Taxonomies:

Right-click the taxonomies you want to compare in Project Explorer to open a context menu, and then
select one of the following:

« Compare With > Each Other

« Cloud Assessment > Compare with the latest on server
« Compare With > Local History

The results are displayed in the Compare view.

EE uddi-com-systinet-re EE Compare {uddi-com-sy &3 ! =0

¥| Taxonomy Structure Compare b 4 @

= @ Contact roles kaxonomy | Contact bypes taxonomy
E Mame
E Taxonany 10
55 Adrinistrator

?, Business Expert

55 Developer
Operations Manager
Organization Unit

'E Person

il il

= Taxonomy Compare Results

¥| MyTaxonomyProjectfuddi-com-systinet-repository-sdm-taxonomies-contactRoles.xml | My...ml
Architect {uddi:systinet, com: soa:model:taxonomies: contactRoles: architect) Missing

Updating Taxonomies from the Server

If the most current version of a taxonomy exists on a server, you can update your local copy to reflect
any changes.

To Update a Local Taxonomy:

« Right-click the taxonomy in Project Explorer to open the context menu, and then select Cloud
Assessment > Update from Server.

Note: Confirmation is required to overwrite existing taxonomies.
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Importing and Exporting Taxonomy Files

You can import and export taxonomies between your projects and your local file system.
To Import a Taxonomy from your File System:

1. In Project Explorer, right-click the taxonomy project to which you want to import taxonomies to
open its context menu, and then select Import > Taxonomy.

The Import Taxonomies wizard opens. For details, see Import Taxonomies, on page 39.
2. Browse for the folder from which you want to export taxonomies in the Folder field.
The selected folder is displayed in the left pane.
3. Click the check box of the chosen folder.
Compatible file types are displayed in the right pane.

4. Click the check box of the files you want to import and, and then browse for the required import
folderin the Into folder field.

5. Click Finish.
6. Publish the taxonomies to an Micro Focus Cloud Assessment repository, as described in
Publishing Taxonomies, on page 29.

TIP:

Tip: When importing a taxonomy from a file whose file name already exists in the local folder,
Taxonomy Editor asks if you want to overwrite the taxonomy. If you click Yes or Yes To All,
the current taxonomy is updated by attributes and categories from the XML file and its status is
changed to modified.

To Export a Taxonomy:

1. Right-click the taxonomy in Project Explorer to open its context menu, and then select Export to
open the Export wizard. For details, see Export Taxonomies Wizard, on page 39.

Select the required file type and click Next to open the corresponding wizard.
Browse for the required destination and enter the required parameters.
Select whether to overwrite existing files.

Click Finish.

NOTE:
Note: You can export a taxonomy to any file type supported by Eclipse. For example:

o XML file
« JAR archive
« EAR-deployable or JAR-deployable archiv

a M oD
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This chapter explains how to deploy a set of taxonomies as an Extension Project.
You can publish individual taxonomies as described in Publishing Taxonomies, below.
Alternatively, create a taxonomy extension and deploy it as described in the following sections:

« Publishing Taxonomies, below
« Building a Taxonomy Extension, on the next page

Applying Extensions , on the next page

« Redeploying the EAR File, on page 32

Publishing Taxonomies

Publishing is the process of updating changes to an Micro Focus Cloud Assessment server.
To Publish a Taxonomy:

« Right-click the taxonomy in the Project Explorer to open its context menu, and then select Cloud
Assessment> Upload to Server. Multiple taxonomies may be selected by holding CTRL and selecting
them.

The taxonomy is published to the defined Micro Focus Cloud Assessment server.

CAUTION:
Caution: You cannot publish a System taxonomy to a remote repository.

The status of a taxonomy after publishing updates as described in the following table.

Taxonomy Status After Publication

Status Description Impact
UP-TO- Local and server versions are identical. Publication was successful, including any
DATE modifications.
NEW » Local version of the taxonomy has not been  Publication was unsuccessful and the status
published to the server. is unchanged. Possibly due to one of the
following:

« Exception error.

« Breach of server data integrity.

MODIFIED Changes have been made to a local version

> of a taxonomy after it has been published.
SYSTEM Taxonomies automatically generated by Changes to these taxonomies cannot be
[% Micro Focus Cloud Assessment. For system  published.

- use only.
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Building a Taxonomy Extension

After publishing taxonomies, you can create a Taxonomy Extension.
To Build a Taxonomy Extension:

1. Right-click the taxonomy project in Project Explorer to open its context menu, and expand Cloud
Assessment > Build Extension to open the location browser.

2. Enter a name for the extension project and browse for the location you want to save the project to,
and click Save.

All taxonomies from the selected taxonomy project are copied to the Taxonomy Extension.

Applying Extensions

You can extend Cloud Assessment by adding libraries or JSPs to the deployed EAR files, by modifying
the data model, by configuring the appearance of the Ul, and by importing prepackaged data.

Extensions to Cloud Assessment come from the following sources:

« Customization Editor

Typical extensions created by Customization Editor contain modifications to the data model and
artifact appearance, and possibly data required by the customization (taxonomies). They may also
contain new web components, which may include custom JSP and Java code.

If your extension contains new artifact types, Cloud Assessment does not create default ACLs for
them. Set default ACLs for the new artifact types in Cloud Assessment. using the functionality
described in "How to Manage Default Access Rights" in the Administration Guide.

« Assertion Editor, Report Editor, and Taxonomy Editor

These extensions contain assertion, reporting, and taxonomy data only. They do not involve
changes to the data model.

The Setup Tool opens the EAR files, applies the extensions, and then repacks the EAR files.
Apply extensions according to one of the following scenarios:

« Single-Step Scenario, on the next page
The Setup Tool performs all the processes involved in applying extensions, including any database
alterations, as a single step.

« Decoupled DB Scenario, on page 32
Database SQL scripts are run manually. The Setup Tool performs the other processes as individual
steps that are executable on demand. This scenario is useful in organizations where the user

applying extensions does not have the right to alter the database, which is done by a database
administrator.

CAUTION:

In some specific circumstances (underscores and numbers in property names), extension
application may fail because Cloud Assessment cannot create short enough database table
names (31 character maximum for most databases).

The errorin setup. log resembles the following:
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[java] --- Nested Exception ---

[java] java.lang.RuntimeException: cannot reduce length of identifier
'ry_c_es_Artifact@2s_c_priEspPty@1Group_c_priEspPtyel’,
rename identifier elements or improve the squeezing algorithm

[java] at com.cloudassessment.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.getUniquelLimitedLengthName(

BlizzardNameProviderImpl.java:432)

[java] at com.cloudassessment.platform.rdbms.design.decomposition.naming.impl.

BlizzardNameProviderImpl.filterTableName(BlizzardNameProviderImpl.java:374)

If you do not require backward compatibility with these older versions, you can change the table
naming algorithm.

To change the table naming algorithm:

1. OpenCloudAssessment_HOME/lib/pl-repository-old.jar#META-
INF/rdbPlatformContext.xml with a text editor.

2. Inthe rdb-nameProvider bean element, edit the following property element:
<property name="platform250Compatible" value="false"/>
3. SaverdbPlatformContext.xml

CAUTION:

This solution only impacts properties with multiple cardinality. If the problem persists or
you need to preserve backward compatibility, then review the property naming
conventions in your extension.

Single-Step Scenario

Follow this scenario if you have permission to alter the database used for Cloud Assessment.
To apply extensions to Cloud Assessment in a single step:

1. Make sure that all extensions are in the following directory:
CloudAssessment_HOME/extensions
The Setup Tool automatically applies all extensions in that directory.

If you are applying extensions to another server, substitute the relevant home directory for
CloudAssessment_HOME

Stop the server.

3. Start the Setup Tool by executing the following command:
CloudAssessment_HOME/bin/setup.bat(sh)

4. Select the Apply Extensions scenario, and click Next.

The Setup Tool automatically validates the step by connecting to the server, copying the
extensions, and merging the SDM configuration.

5. Click Next for each of the validation steps and the setup execution.
This process takes some time.

6. Click Finish to end the process.
Deploy the EAR file:
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The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see Redeploying the EAR File.
8. Restart the server.

CAUTION:
Applying an extension that modifies the SDM model may drop your full text indices.

CloudAssessment_HOME/log/setup.log contains the following line in these cases:

Could not apply alteration scripts, application will continue with slower DB
drop/create/restore scenario. ...

In these cases, reapply full text indices. as described in the "Enabling Full Text Search" section
of the Micro Focus Cloud Assessment Installation and Deployment Guide.

Decoupled DB Scenario

Follow this scenario if the user who applies extensions does not have permission to modify the
database.

To apply extensions and modify the database separately:

1. Make sure that all extensions are in the following directory:
CloudAssessment_HOME/extensions
The Setup Tool automatically applies all extensions in that directory.
Stop the server.
Start the Setup Tool by executing the following command:
CloudAssessment_HOME/bin/setup -a.
4. Select the Apply Extensions scenario, and click Next.
Click Next, to execute the extension application, and exit the Setup Tool.
Provide the scripts from CloudAssessment_HOME/sql to the database administrator.

The database administrator can use all. sql to execute the scripts that drop and recreate the
database schema.

7. Execute the Setup Tool in command-line mode to finish the extension application:
CloudAssessment_ HOME/bin/setup -c

8. Redeploy the EAR file:
The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see Redeploying the EAR File.

Redeploying the EAR File

After using the Setup Tool to apply extensions or updates, you must redeploy the EAR file to the
application server. For JBoss, you can do this using the Setup Tool.

To Redeploy the EAR file to JBoss:
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Stop the application server.
2. Start the Setup Tool by executing the following command:
CloudAssessment_HOME/bin/setup.bat(sh)
3. Select the Advanced scenario, and click Next.
Scroll down, select Deployment, and then click Next.
When the Setup Tool validates the existence of the JBoss Deployment folder, click Next.
5. Click Finish to close the Setup Tool.
6. Restart the application server.
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Editing taxonomies can result in validation and conflict issues, as described in the following sections:

« Local Validity, below
« Server Conflicts, below

« Repair Action, on the next page

Local Validity

By default, the validity of local taxonomies is constantly checked as you modify them.. Invalid taxonomies
are marked in Project Explorer and the associated errors are listed in the Problems view. For example, errors
for two taxonomies with the same ID can be seen in the following screenshot.

Screenshot: Invalid Local Taxonomies

= t@ MyTaxonomyProject [HP S0& Systinet Sel|| Overview | Categories | Advanced | Source

+-{5) Reference artifact taxonomy, [rev.1] | = 5 -
¥ artfack bypes baxonamy, [rev.2] [ Prablems &35 & Histary | (5] validation Results

#-&) Associated application baxonomy [rev, | 2 errors, O warnings, O infos

() Computer bypes taxonomy [rev.1] Description Resource Path Location
# (=) Contact roles taxononmy [rev.1] = % Errors (2 items)

+-) Contact types kaxonomy [rev.1] @ Taxonomy ID is duplicated by another local taxonomy  uddi-com-systinet-...  MyTaxonomyProject line 1

+] @ > Contrack Agreement States [rev.4] @ Taxonomy ID is duplicated by another local taxonomy  uddi-com-systinet-...  MyTaxonomyProject line 1

To disable validation, from the menu, deselect Build automatically.

Server Conflicts

A local taxonomy and the version on a server can come into conflict either when the version on the server is
changed or when changes to the local version affect artifacts on the server.

Conflicts are displayed when you try to publish the taxonomy. An error message is displayed, stating that the
taxonomy could not be published.

To help prevent conflicts, you can do the following:
« Right-click the taxonomy in Project Explorer to open its context menu, and then select one of the following:
o Cloud Assessment > Show Taxonomy Usage
All artifacts categorized by the taxonomy are displayed in the Taxonomy Usage view.

o Right-click the taxonomy in Project Explorer to open its context menu, and then select Cloud
Assessment > Validate Data Consistency

Conflicts are displayed in the Validation Results view.
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Screenshot: Validation Results

EI Yalidation Results &3
1 problems Found
= (2% axonomy project
=iz} Lifecycle stages taxonomy.
== Testing
—- &) Categary Usage

L3 My Business Service | Maormal artifact
£ Testing Business Services | artifact has data
{3 Testing Business Services
Bl Defaul Lifecydle
5| My Gowvernance Process

Mo standard artifact

Repair Action

The Data Consistency Check reports artifacts that use categories which no longer exist in the
taxonomy project.

Taxonomy Editor features a Repair Action which enables you to resolve these inconsistencies.

To Repair an Inconsistency:

1. Inthe Validation Results view, expand the problem category, and right-click an artifact to open its
context menu, then select one of the following:

« Remove Referenced Category From Artifact
« Change Category
2. Re-runvalidation.

NOTE:
Note: Some conflicts relate to the validity of policy and lifecycle data (non-standard artifacts).

The repair actions cannot resolve these conflicts.
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In this example, you create and deploy a new taxonomy containing the identities of departments in your
organization.

Before proceeding, you must do the following:
« Define your Micro Focus Cloud Assessment server.
« Update the local taxonomies, as described in Updating Taxonomies from the Server, on page 27.
To Create a Department Taxonomy:
1. Create a new taxonomy, entering Departments as the Taxonomy Name.
For details of the procedure, see Creating Taxonomies, on page 23.
Open the Editor for the Departments taxonomy and select the Categories tab.
3. Add the following categories:
« HR
o IT
« Payroll
« Finance
» Sales
« Development
« QA
For details of the procedure, see Adding a Category, on page 25.
4. Press Ctrl+S to save the taxonomy.
The Departments taxonomy is now visible in Project Explorer.
5. Right-click the Departments taxonomy to open its context menu, and then select one of the following:
o Cloud Assessment > Publish Taxonomy
To publish the taxonomy to the defined Micro Focus Cloud Assessment server.
« Cloud Assessment > Publish To Other Server
To publish the taxonomy to a different server.

Cloud Assessment (1.01) Page 36 of 45



Appendix A: Keyboard Shortcuts

Shortcut

CtrI+Alt+S

Ctri+N

Alt+A, Insert

Alt+C

Alt+U, Ctrl+ArrowUp
Alt+D, Ctrl+ArrowDown
Alt+E, Ctri+ArrowLeft
Alt+l, Ctrl+ArrowRight
F2

Esc

Ctrl+PgDn

Ctri+PgUp

F12
Ctrl+W, Ctrl+F4

Ctrl+Shift+W,
Ctrl+Shift+F4

Ctrl+F6
Ctrl+Shift+F6
Ctrl+Shift+E
Ctrl+J

Ctrl+H
Alt+Shift+W
F5

Ctrl+S

Cloud Assessment (1.01)

Action

Add Micro Focus Cloud Assessment server.
New taxonomy.

Add next category.

Add child category.

Move category up.

Move category down.

Move category left (unindent).

Move category right (indent).

Navigate to Category Name field.

Ignore changes in current test field and switch to Category
Structure

Switch to next editor tab.

Switch to previous editor tab.

Activate Editor.
Close current editor.

Close all editors.

Go to next editor.

Go to previous editor.

Switch to editor.

Quick find taxonomy.

Search taxonomy or category.

Show editing resource in Taxonomy Editor.
Refresh items.

Save changes for active editor.

Context
Global

Global
Categories tab
Categories tab
Categories tab
Categories tab
Categories tab
Categories tab
Categories tab

Categories tab

Taxonomy
Editor

Taxonomy
Editor

Global
Global

Global

Global
Global
Global
Global
Global
Global
Global

Global
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Shortcut
Ctrl+Shift+S
Ctrl+C, Ctrl+Insert
Ctrl+X, Shift+Delete
Delete

Ctrl+V, shift¥Insert

Ctrl+Shift+L

Cloud Assessment (1.01)

Action

Save changes for all editors.

Copy
Cut
Delete
Paste

Show key assist

Context
Global
Global
Global
Global
Global

Global
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Each Taxonomy Editor input dialog is described in the following sections:

« Import Taxonomies, below
« Export Taxonomies Wizard, below
« Find Taxonomy Dialog, on page 41

o Search Taxonomy Dialog, on page 42

Import Taxonomies

Select taxonomy files to import into your taxonomy project:

3 Import Taxonomies

Import Taxonomies
Select kaxonomy files to import into taxonomy project
Folder | C:iDocuments and SettingsijeffiMy Documents w
EREIESE 1 Documents [ [¥] taxonomyLifecycdestages, xml #
[ (%] toc.xml
[ [¥] toc-ae.xml
X| uddi-com-systinet-repositary-
X| uddi-com-systinet-repositary-
X| uddi-com-systinet-repositary-
X| uddi-com-systinet-repositary-
K] web,xml
v
¥
Select Al ] [ Deselect Al ]
Into folder: | MyTaxonomyProject
@ Finish ] [ Cancel
Parameter Definition
Folder Browse for the source folder containing the taxonomy files you want to import.

Left Pane  Select the source folder containing the taxonomy files you want to import.
Right Pane Select the individual taxonomy files you want to import.

Into Folder Browse for the destination folder into which you want to import the selected taxonomies.

Export Taxonomies Wizard

Select a destination for the taxonomies you wish to export:
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Select

Export resources to the local file system,

Select an export destination:

|type filker bext

== General
& ant Buidfiles
B archive File
94 Breakpaints

(= EB
b EJB JAR file
([ J2EE
app Client JAR file
{25 EaR file
& AR file
= Java
0 38R file
1 1avadoc
(== Plug-in Development
@ Deplovable Features
% Deployable plug-ins and Fragments
,E Eclipse product
== Team
fEI Team Project Set
== web
1B war file

@ < Back Finish

Cancel

Parameter Definition

Select an export destination  Enter text to filter your search.
Tree View Select File System as your destination folder.

Select the taxonomies you want to export, then browse for the destination directory:
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File system
Flease enter a destination directory.

& [Z](54 HP S0A Systinet [HP SOA Systinet Server | [¥] ? .project

D@- Mercury [HP SOA Systinet Server on localh ? repository

£ i1l ] |

[SelectTypes...J [ Select Al J [ Deselect Al J

To directory: | Vl [ Browse, .. ]

Optons

[ ] overwrite existing files without warning
() Create directory structure for files

{®) Create only selected directories

Parameter Definition
Left Pane Select the project from which you want to export taxonomies.
Right Pane Select the individual taxonomies you want to export.

To Browse for and select the directory into which you want to export the selected
Directory taxonomies.

Find Taxonomy Dialog

A quick search for matching taxonomies:
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Select taxonomy to find (7 = any character, * = any string)

Matching taxonomies:

X

@Taxonomy—ol

In project:

[E5HP 505 Systinet Taxonomy Project-01

@ [ Open Taxonomy ] [ Done

Parameter Definition
Top Field Enter text to filter your search results.
Matching Taxonomies A list of taxonomies matching your search request.

In Project Select the project in which you want to search for taxonomies.

Search Taxonomy Dialog

An advanced search for matching taxonomies:

A Search fz

o

[ sOM search | 557 File Search || 27 Java Search | %57 Plug-in Search | (] Taxonomy Search |_

Conkaining kext:

| Contact A4 |

(*=anything, *=any character)
Search only in Search contraols
Taxonamies Case sensitive

Mame ['whale words only
Description |:| Regular expression

o
Cateqories

Marme
Value

Scope
() Workspace Selected resources

(O working set: |[ Choose.., ]

@ Search H Cancel ]
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Parameter Definition

Containing Enter text to search or use the drop-down menu to select a previous search
Text parameter.

Working Set Browse for and select a working set as a scope for your search.
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Case Indications

A taxonomy was  Your local taxonomy is
changed on the CONFLICTING. The local
remote server version cannot be

while you were published and its
modifying your modifications are kept.
local version.

Ataxonomy was Taxonomy is

published that
has the same file
name as a new

version cannot be

taxonomy you local taxonomy and server
are trying to remain in Project

publish to the Explorer.

remote server.

The taxonomy The local taxonomy

you have created
has the same ID
as an existing
taxonomy on the

cannot be published.
Changes to the local
taxonomy and server
remain in Project

remote server Explorer. The Validation
Results include a node
giving the taxonomy ID.

You have The local taxonomy

changed the ID of
a taxonomy used

cannot be published and

by artifacts. Validation Results list
artifacts that use the
taxonomy.

A category that The local taxonomy

you modified is cannot be published and

used by other remains MODIFIED.

artifacts. Validation Results lists

artifacts that use the
category.

A new taxonomy
ID is identical to
that of another
local taxonomy.

taxonomy is shown.

Cloud Assessment (1.01)

CONFLICTING. The local

published. Changes to the

remains MODIFIED. The

An error message for this

Resolution Type

To replace the local taxonomy  Conflict
with the server version, use

the taxonomy context action

Cloud Assessment >

Update Taxonomy. You

might want to first copy your

local version to a temporary

location.

To replace the local taxonomy  Conflict
with the remote server

version, use the taxonomy

context action Cloud

Assessment > Update

Taxonomy. You might want

to first make a backup copy

your local version.

Change the ID of the new Validation
taxonomy. Results
To restore the original Validation
taxonomy, use the taxonomy  Results
context action Cloud

Assessment > Update

Taxonomy.

To restore the original Validation
taxonomy, use the taxonomy  Results
context action Cloud

Assessment > Update

Taxonomy.

Change taxonomy ID to Local

another value.

Severity

Error

Error

Error

Error

Error

Error

Inconsistency
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Case Indications

Taxonomy ID A warning message for
format is invalid.  this taxonomy is shown.

Category valueis  An error message for this
duplicated by taxonomy is shown.
another category

in the same

taxonomy.

Taxonomy file An error message for this
name contains taxonomy is shown.
invalid character

for REST URL.

Cloud Assessment (1.01)

Resolution

Change taxonomy ID to valid
format.

Change the category value.

Change file name so that it
does not contain invalid
character.

Type Severity

Local Warning
Inconsistency

Local Error
Inconsistency

Local Error
Inconsistency
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